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Introduction

Your Epson Stylus® Photo R1900 Series printer gives you beautiful archival prints
on a wide variety of glossy and matte papers in many sizes.

Your outstanding printouts result from these advanced features:

B Eight individual Epson UltraChrome Hi-Gloss® 2 ink cartridges, including
red and orange inks for improved facial tones and increased vibrancy.

B Improved gloss optimizer cartridge provides a smooth, uniform glossy coat on
glossy papers for an unprecedented look and feel.

B  Enhanced media handling of sheets and rolls for virtually any kind of print up
to 13 x 44 inches, with or without borders.

B Advanced Radiance™ technology for maximizing color gamut volume while
providing smoother color transitions.

B Resolutions up to 5760 x 1440 optimized dpi (dots per inch) with
1.5 picoliter droplets for the finest details.

B Direct printing onto ink jet-printable CDs and DVDs for
professional-looking labels.

B Two Hi-speed USB 2.0 ports for fast, easy connectivity to multiple
computers.

B Downloadable premium ICC color profiles for precise color management.

Please follow these guidelines as you read the instructions on your Start Here sheet,
User’s Guide book, and on-screen Reference Guide:

Warning:
Warnings must be followed carefully to avoid bodily injury.

Caution:
Cautions must be observed to avoid damage to your equipment.

Note:
Notes contain important information about your R1900 Series.

Tip:
Tips contain hints for better printing.
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Loading Paper

You can print on a variety of paper sheets in the sheet feeder, or use the single sheet
guide and manual feed slot for certain specialty papers (see page 8). For multiple
photos, panoramics, and banners, load roll paper using the roll paper holders (see

page 10).

Loading Paper in the Sheet Feeder

You can load the following paper types and quantities in the sheet feeder. Load
other paper types in the manual feed slot using the single sheet feeder (see page 8).

Paper type Maximum sheets by size
Plain paper 120
Epson® Presentation Paper Matte 100

50 (B or Super B)

Epson Bright White Paper

80

Epson Photo Paper Glossy

30 (all sizes)

Epson Premium Photo Paper Glossy

30 (4 x 6inch, 8 x 10 inch, Letter,
11 x 14 inch)

20 (5 x 7 inch)

10 (B, A3, Super B)

Epson Ultra Premium Photo Paper Glossy

30 (4 x 6inch, 8 x 10 inch, Letter)
20 (5 x 7 inch)

Epson Ultra Premium Photo Paper Luster
Epson Ultra Premium Presentation Paper Matte

30 (Letter)
10 (A3 or Super B)

Epson Premium Photo Paper Semi-gloss

30 (4 x 6 inch or Letter)
10 (B)
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Paper type Maximum sheets by size

Epson Premium Presentation Paper Matte 30 (8 x 10 inch or Letter)
10 (11 x 14 inch, A3, or Super B)
Epson Premium Presentation Paper Matte 1 sheet
Double-sided

Epson Photo Quality Self-adhesive Sheets
Epson Iron-on Cool Peel Transfer Paper

1. Open the paper support and pull up the extensions, then open the output tray
and pull out the extensions.

2. Insert paper, glossy or printable side up, short edge first, against the right side
and beneath the tab. Then slide the edge guide against the paper.

Wider paper Narrower paper

Always load paper short edge first, even for landscape printing.
Load letterhead or pre-printed paper top edge first.

Note:

The edge guide may move slightly during paper feeding and
printing. Do not adjust the edge guide or open the printer cover
during printing.
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Loading Paper Using the Single Sheet
Guide

You can print professional quality photos on these paper types using the single
sheet guide and the manual feed slot:

(See page 13 for available sizes.)
1.

5.

Epson Velvet Fine Art Paper

Epson Watercolor Paper Radiant White

Epson UltraSmooth® Fine Art Paper 250 gsm
PremierArt™ Matte Scrapbook Photo Paper for Epson

Roll paper

Remove any paper from the sheet feeder and edge guide

close the paper support.

Open the output tray and pull out the
extensions.

Slide the roll paper edge guide on the back of the
printer all the way to the right.

Attach the single sheet guide by aligning the notches on its base with the slots
on the back of the printer. Then hook the tabs over the top of the slot
(marked with orange triang]es).

Turn on the printer so it can load the paper correctly.
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6. Insert one sheet of paper, printable side up and against the right side, then
slide the edge guide against the sheet, but not too tightly.

Note:
Load paper short edge first, no matter which way your photo faces. Check the
paper package for any additional loading instructions.

7. Push the paper into the printer until it meets resistance and hold it there until
the printer pulls it in slightly. Once the printer begins feeding the paper, let go
of it.

8. Open the printer cover and make sure the = \ ‘ :
paper has fed all the way into the printerand "
is straight. The paper must feed straight so the
printer can properly identify the edge of it.

If the paper is crooked or the front edge is
visible, you may receive a paper jam error
when you print. To avoid this, press and hold
the @ roll paper button for three seconds to
back the paper out. Press the v@ paper button
to clear the paper out error, then load the
paper again.

9. Close the printer cover and do not open it during printing.
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Loading Roll Paper

You can load roll paper or canvas media to print large, panoramic images or
multiple photos, with or without borders.

You can load Epson roll paper in these widths:
B 8.3-inches wide
B 13-inches wide

(See page 13 for a list of roll paper and canvas media types and sizes.)

Tip:

It's a good idea to check the ink status and replace cartridges, if necessary, before
loading on roll paper (see page 36). This is because you must remove roll paper from
the printer before replacing cartridges to avoid ink marks on the paper.

1. Turn on the printer.

2. Remove any paper loaded in the sheet feeder and remove the single sheet
guide, if it is installed (see page 8). Also close the paper support.

3. Open the output tray, but do not pull out the extensions.

5. Remove any tape and protective paper from the end
of the roll and make sure the corners of the paper are
cut at 90° angles to avoid paper feeding problems.
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Note:
Avoid touching the surface of your paper or canvas media.

With canvas media that you have previously loaded, it's a good idea to cut the edge
straight each time you reload it.

Insert the left roll paper holder (marked with a down orange triangle) into the
far left slot on the back of the printer (marked with a right orange triangle).
Then insert the right roll paper holder in the corresponding slot on the right.

Feed the end of the paper into the roll paper feeder,
located behind the roll and marked with the @ roll
paper icon.

Slide the roll paper edge guide against the right side
of the paper, but not too tightly.
Caution:

Do not load roll paper or canvas media into the manual
feed slot (marked with up orange triangles).

Guide the paper into the slot and hold it for a few seconds until the printer
feeds in the paper automatically.

Note:

When loading canvas media, leave two to three inches of slack in the roll as it feeds

and prints for the best results. If you have trouble feeding canvas media, check that
the edge is straight and reload it, making sure to keep the roll slack.

Loading Paper
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10. Open the printer cover and look into the
printer to make sure the roll paper or canvas
media is feeding straight. The paper must feed
straight so the printer can properly identify the
edge of it.

If it is crooked or the front edge is visible, you
may receive a paper jam error when you print.
To avoid this, press the @ roll paper button for
three seconds to back the paper out. Press the
p@ paper button to clear the paper out error,
then load the roll paper or canvas media again.

11. For roll paper, turn the knobs on the roll paper holders backward to remove
excess slack. (Leave two to three inches of slack on canvas media.)

12. Close the printer cover and do not open it during printing.

Removing Roll Paper Prints and Roll Paper

1. To remove your roll paper or canvas media prints, press the @ roll paper
button to feed the paper forward, then cut off your printed photos straight
across the paper at the cutting guideline.

Caution:
Do not pull on the paper as you cut it to avoid damaging your printout. Also do not
cut the paper too close to the printer to avoid paper feeding problems.

2. To continue printing on roll paper or canvas media, press the @ roll paper
button again to return the paper to printing position.

3. Ifyou are finished printing on roll paper or canvas media, press the @ roll
paper button for three seconds to feed the paper backwards and out of the
printer. If it does not feed all the way out, press the @ roll paper button again.

4. Turn the knobs on the roll paper holders backward to roll up the paper, then
remove the paper and holders from the printer.

5. DPress the p@ paper button to stop the 5@ paper light from flashing.

Store the unused roll paper or canvas media in its original package away from high
temperatures, humidity, and direct sunlight.
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Available Epson Papers

Epson offers a wide array of high quality papers, making it easy to maximize the
impact of your photos, presentations, and creative projects.

You can purchase genuine Epson ink and paper at Epson Supplies Central*™ at
www.epson.com/ink3 (U.S. sales) or www.epson.ca (Canadian sales). You can

also purchase supplies from an Epson authorized reseller. To find the nearest one,

call 800-GO-EPSON (800-463-7766).

Part Sheet
Paper name Size number | count
Epson Premium Photo Paper 4 x 6 inches S041808 | 40
Glossy S041727 | 100
5 x 7 inches S041464 | 20
8 x 10 inches S041465 | 20
Letter (8.5 x 11 inches) S041286 | 20
S041667 | 50
11 x 14 inches S041466 | 20
B (11 x 17 inches) S041290 | 20
A3 (11.7 x 16.5 inches) S041288 | 20
Super B (13 x 19 inches) | S041289 | 20
8.3 inches x 32 feet S041376 | Roll
13 inches x 32 feet S041378 | Roll
Epson Ultra Premium Photo Paper | 4 x 6 inches S041934 | 50
Gloss
Y Letter (8.5 x 11 inches) S041935 | 20
Epson Photo Paper Glossy 4 x 6 inches S041809 | 50
S042038 | 100
Letter (8.5 x 11 inches) S041141 | 20
S041649 | 50
S041271 100
B (11 x 17 inches) S041156 | 20
Super B (13 x 19 inches) | S041143 | 20

Loading Paper
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Part Sheet
Paper name Size number | count
Epson Premium Photo Paper 4 x 6 inches S041982 | 40
Semigloss Letter (8.5 x 11 inches) | S041331 | 20
Super B (13 x 19 inches) | S041327 | 20
Epson Ultra Premium Photo Paper | Letter (8.5 x 11 inches) S041405 | 50
Luster A3(11.7 x 16,5 inches) | S041406 | 50
Super B (13 x 19 inches) | S041407 | 50
8.3 inches x 32.8 feet S041408 | Roll
13 inches x 32.8 feet S041409 | Roll
Epson Ultra Premium Presentation | Letter (8.5 x 11 inches) S041341 | 50
Paper Matte A3(11.7 x 16,5 inches) | S041343 | 50
Super B (13 x 19 inches) | S041339 | 50
Epson Premium Presentation 8 x 10 inches S041467 | 50
Paper Matte Letter (8.5 x 11 inches) | S041257 | 50
11 x 14 inches S041468 | 50
A3 (11.7 x 16.5 inches) S041260 | 50
Super B (13 x 19 inches) | S041263 | 50
Epson Premium Presentation Letter (8.5 x 11 inches) S041568 | 50
Paper Matte Double-sided
Epson Presentation Paper Matte Letter (8.5 x 11 inches) S041062 | 100
Legal (8.5 x 14 inches) S041067 | 100
B (11 x 17 inches) S041070 | 100
Super B (13 x 19 inches) | S041069 | 100
Epson Velvet Fine Art Paper Letter (8.5 x 11 inches) S041636 | 20
Super B (13 x 19 inches) | S041637 | 20
Epson Watercolor Paper Radiant Super B (13 x 19 inches) | S041351 | 20
White
Epson UltraSmooth Fine Art Paper | Super B (13 x 19 inches) | S041896 | 25

250 gsm
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Part Sheet
Paper name Size number | count
PremierArt Matte Scrapbook Photo | Letter (8.5 x 11 inches) SCR1002 | 20
P for E
aperfor Epson 12 x 12 inches SCR1003 | 10
PremierArt Water Resistant 13 inches x 20 feet SP91220 | Roll
Canvas for Epson
Piezo Pro® Matte Canvas for Epson | 13 inches x 20 feet S041992 | Roll
Epson Bright White Paper Letter (8.5 x 11 inches) S041586 | 500
Epson Photo Quality Self-adhesive | A4 (8.3 x 11.7 inches) S041106 | 10
Sheets
Epson Iron-on Cool Peel Transfer Letter (8.5 x 11 inches) S041153 | 10

Paper

Loading Paper
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Printing From Start to Finish

This section describes basic printing from your Windows® or Macintosh®
computer. For detailed instructions, see the on-screen Reference Guide.

You can also print label designs directly onto ink jet-printable CDs or DVDs. See
page 30 and the on-screen Reference Guide for details.

To print photos directly from a PictBridge-compatible digital camera connected to
the R1900 Series, see the on-screen Reference Guide.

Tip:

It's a good idea to check for updates to your Epson Stylus Photo R1900 Series software.
See "“Checking for Software Updates” on page 41 for instructions.

Printing in Windows

1. Open a photo or document in a printing program, open the File menu, and
select Print.

Location:
Commert:

Page Range
@Al
Selection

Pages

Curent Page

Number of copies: 1

Collate

11 22 53]

Print.

= Print =)
General
Select Printer
i Add Printer Select EPSON Stylus
BRSO Stylus Phote RI900 Seris .
= Microsoft XPS Document Writer Photo R1900 Series
Setus: Ready Brritone [P Click here to open

your printer software

2. Select EPSON Stylus Photo R1900 Series and click the Preferences or
Properties button.

Note:

If you see a Setup, Printer, or Options button, click it. Then click Preferences or
Properties on the next screen.
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W Draft: for rough drafts with reduced print quality

On the Main tab, select one of the following as the Quality Option setting:

B Text: for documents containing text or images with standard print

quality

B Text & Image: for documents with text or images with better print

quality

Photo: for photos and graphics with good print quality and speed

Best Photo: for photos or graphics with high print quality

Select your document
type (choose Photo or
Best Photo for photos)

Select your paper
Source, Type,

and Size

Click here for

borderless photos

= Printing Preferences (=)
Gl Main | &% Advanced | 5 Page Layout | & Maintenance |
Dualty Dpfion
p p 5
= v
H =l L
@) Drat @ Test  © Testhlmage () FPhoto @ Best Phato
Paper Options: Print Options S
elect an
DG Ao~ necessary Print
Type: Premium Photo Paper Glossy - PR o
Obtions
Size: AZ[M1.78 1650 - [ Prirt Preview p
© Burders | @ Baierees
Tnk Tevek Orientati
o \ Select your
G G G D B ® ot \//'\ document or photo
(@) Landscape Y . .
S5 Orientation
[ ok J[ Cenesl ][ Heo ]

Choose the paper Source in which you loaded your paper:

B Sheet: for sheets of paper loaded in the sheet feeder

B Roll: for roll paper or canvas media loaded in the roll paper holder
(see page 10 for loading instructions; see the on-screen Reference Guide for
instructions on selecting roll paper options using the Settings button)

B Manual - Roll: for a sheet of compatible paper loaded in the manual feed
slot using the single sheet guide (see page 8 for loading instructions)

B CD/DVD: for a disc loaded in the CD/DVD tray guide (see page 30 for
printing instructions)

Choose the correct paper Type setting for your paper (see page 22).

Choose the size of the paper sheets you loaded as the Size setting.

Printing From Start to Finish
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For roll paper or canvas media, select the width of your roll as the Size setting.
Select A4 for 8.3-inch rolls or Super B for 13-inch rolls.
Note:

For roll paper, make sure the maximum width of your photo is set to 8.3 or
13 inches to fit in the width of your roll paper.

7. To print borderless photos on compatible paper, select Borderless, if
available.

8. To reduce or enlarge your printout, print double-sided, or adjust the
borderless expansion setting, click the Page Layout tab and select settings as
necessary. (Click Help or see your on-screen Reference Guide for details.)

9. For more printing options, click the Advanced tab.

0 Printing Preferences =]
|8 Main | &3 Advanced [ ) Page Layout | 6 Maintenance:
Paper & Quality Dptions Color Management
Sheet | | Settings(D).. @ Celor Controls
" ot Paner Gl ) PhoteE rhance
. . remium Photo Paper Glossy -
Print quality 1
i Photo RPM s -
settn Color Mode | EPSON Vivid -
d A3(11.7 1651 - oler Hode
@) Borders @ Boiderless
Orientation Reset Canirals
© Portrait 7 Landscape - +
Brightness |+ 10 E
Fiint Dptions
[T Rieuerse Order Copnast | +0 U
Satuation [+0 )
7] High Speed Cyan © [+0 5
] Edge Smoothing
[ Print Preview Magenta @ |+0 @
Yellow O [+0 &

Custom Settngs | Save Setling.
Reset Defauls | | Online Support

[ ok J[ cancel ][ Heb

[T Show this screen first

10. Select a print quality setting (available settings depend on selected paper type):
Economy: for the fastest printing with reduced quality on plain paper

Normal: for everyday text and image printing

B Draft: for the fastest photo printing with draft quality
B Photo: for photos and graphics with good print quality and speed
B Best Photo: for photos and graphics with high print quality and slower

speed (good to use for canvas media)

B Photo RPM® : for the best print quality and slowest print speed (best to
use for canvas media)
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Note:
For color management instructions, see page 23. For more information about print
settings, click Help or see your on-screen Reference Guide.

11. Click OK to save your settings.
12. Click OK or Print to start printing,.

This window appears and shows the progress of your print job.

.
[T EPSON Stylus Photo R1900 Series - USB00L =
Uniiled - Motepad Pageti2

Media Type : Plain Paper / Bright White Paper x |
Paper Size : Letter (31425 1110
Check ink =

cartridge status —— Cancel
printing

oo ) pawse ]| 'Slnp ] Buy Epson Ink |

Pause orresume
prl nti ﬂg cg:tﬁ'degaes'esu 5, make sure you ure genuine Epsaon inl ‘ Details.

Note:
If you're printing on roll paper or canvas media, see page 12 for instructions on
removing your printed photos and paper.

Printing With a Macintosh

1. Open a photo or document in a printing program, open the File menu, and
select Page Setup.

Settings: | Page Attributes 4
Format for: [ Stylus Photo R1900 = —— Select Stylus Photo R1900
EPSON SP R1900 (1)
Paper Size: | US Letter B I Select your Paper Size

8.50in x 1100 in

. Select your document

or image orientation

Orientation

Scale: | 100 %

@ ()
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2. Select the Paper Size setting for the paper size and source you are using:

B To print a borderless photo on paper loaded in the sheet feeder, select the
paper size with a Sheet Feeder - Borderless option.

B To print on roll paper, select the size of your photo with a Roll Paper or
Roll Paper - Borderless option. (To eliminate space between photos on
certain sizes, select a Roll Paper - Borderless Banner option.)

Note:
For roll paper, make sure the maximum width of your photo is set to 8.3 or
13 inches to fit in the width of your roll paper.

Bm  To print on paper loaded in the manual feed slot using the single sheet
guide, select a paper size with a Manual - Roll or Manual - Roll
(Borderless) option.

Select the orientation of your document or photo as the Orientation setting.

Click OK.

Open the File menu and select Print.

AN A

Select Stylus Photo R1900, choose Print Settings from the pop-up menu,
and select the following print settings:

Printer: | Stylus Photo R1900

Pop-up menu

Presets: | Standard

ar| |ak| 4w

Select your Media Type

Print Settings

Page Setup: Standard (see page 22)

Media Type: Premium Photo Paper Glossy ! :'}—
Color: [ Colar #+—+— Select Color or Grayscale
Mode: () Automatic | output

@ Advanced

Print Quality: | Photo RPM =) Select Aut ti
elec utomatic or

™ High Speed
& (I Mirror Image Advanced mode
V! Finest Detail

Gloss Optimizer: On L :]

(@) (PoFv ) (preview ) ( Supplies.. ) (“cancel ) EPrint )

Note:
In certain programs, you may need to select Advanced before you can select Print
Settings. For more information about print settings, click the ? button.

7. Select the Media Type setting for your paper (see page 22).
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8. Select Color or Grayscale output in the Color pop-up menu.

9. For basic printing, select Automatic as the Mode setting and move the
Quality/Speed slider to select higher quality or faster print speed.

10. For more printing options, click the Advanced button.

11. Select a Print Quality setting (available settings depend on selected paper

type):

Economy: for the fastes printing with reduced quality on plain paper

speed (good to use for canvas media)

Normal: for everyday text and image printing

Draft: for the fastest photo printing with draft quality

Photo: for photos and graphics with good print quality and speed

Best Photo: for photos and graphics with high print quality and slower

B Photo RPM: for the best print quality and slowest print speed (best to use

for canvas media)

Note:

For color management instructions, see page 23. For more information about print
settings, click ? or see your on-screen Reference Guide.

12. Click Print.

13. To monitor your print job, click the printer icon in the dock (or click the
Print Center icon and double-click SP R1900 on the next screen).

Note:

Cancel
printing

Pause or
resume
printing

Selectthe
print job

Status

{ Active | Completed !

Untitled
Page 1 of 2

\“ Processing job

A Name

[XsXG) Stylus Photo R1900 =
= B
| € o '{‘é’ €
Delete | Hold Stop Jobs Utility Supply Levels

Printing Untitled

If you're printing on roll paper or canvas media, see page 12 for instructions on

removing your printed photos and paper, if necessary.

Printing From Start to Finish 21



Selecting the Correct Paper Type

Select the correct Type (see page 17) or Media Type (see page 20) setting in your
printer software so the ink coverage can be adjusted for your media.

For this paper/media

Select this setting

Epson Premium Photo Paper Glossy
Epson Ultra Premium Photo Paper Glossy

Premium Photo Paper Glossy

Plain paper
Epson Bright White Paper

Plain Paper/Bright White Paper

Epson Photo Paper Glossy

Photo Paper Glossy

Epson Presentation Paper Matte

Presentation Paper Matte

Epson Premium Photo Paper Semi-gloss

Premium Photo Paper Semi-Gloss

Epson Ultra Premium Photo Paper Luster
PremierArt Water Resistant Canvas for
Epson*

Ultra Premium Photo Paper Luster

Epson Ultra Premium Presentation Paper
Matte

Ultra Premium Presentation Matte

Epson Premium Presentation Paper Matte
Piezo Pro Matte Canvas for Epson*

Epson Photo Quality Self-adhesive Sheets
Epson Iron-on Cool Peel Transfer Paper

Premium Presentation Paper Matte

Epson Velvet Fine Art Paper

Velvet Fine Art Paper

Epson Watercolor Paper Radiant White

Watercolor Paper - Radiant White

Epson UltraSmooth Fine Art Paper 250 gsm
PremierArt Matte Scrapbook Photo Paper for
Epson

UltraSmooth Fine Art Paper

Epson Premium Presentation Paper Matte
Double-sided

Double-Sided Matte Paper

Ink jet-printable CD or DVD

CDb/DVD

CD/DVD Premium Surface

* For the best results on this paper, print using a premium ICC profile, downloadable
from Epson at http://www.epson.com/SPR1900Profiles.
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Managing Color With Profiles

For the most precise color in your prints, you can use profiles designed specifically
for your printer model and paper type. Basic profiles are installed with your
printer driver, and you may also have downloaded Premium ICC profiles from
Epson when you installed your printer software.

Follow the instructions in this chapter to use Adobe® Photoshop® 7, CS, CS2, or
CS3 to print with profiles using Photoshop color management (the steps show
only CS3 screens). For additional details, see the on-screen Reference Guide.

Note:
It's important to turn off color management in your printer software when you use
Photoshop color management or you'll get unexpected results.

See these sections for instructions:
B “Windows Printing With a Color Profile” below
B “Macintosh Printing With a Color Profile” on page 27

Note:

Assigning a profile to your image doesn't alter it, only the interpretation of it by your
software and how it appears on your monitor and in a printout. This is the best way to
improve the color balance and contrast in your image.

Windows Printing With a Color Profile

First set up your color management environment in Photoshop and assign a
profile to your image, then select your print settings and print.

Setting Up Photoshop and Assigning a Profile
1. Open Photoshop.

2. Select Color Settings from the Edit menu.
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You see this window:

Colar Settings ===
£ | Por o il el i, e o el v
L) S L S
Sesbes St el ]
Conas D)
v
More Qptions
Prepew

Harth s Brerm £ Bwar o of Cortent For o st
orbtaoes i Merth A, EMTE vakoms arw praservecd. Brfie maermga e
okt

3. Select U.S. Prepress Defaults or North America Prepress 2 from the
Settings menu to set Adobe RGB (1998) as the color space. Click OK.

4. Open the photo you want to print.

If you see an Embedded Profile Mismatch message, select Use the
embedded profile and click OK.

If you see a Missing Profile message, select Assign working RGB: Adobe
RGB (1998) and click OK.

5. When your image appears, evaluate the color balance and contrast. If they

need improvement, select Image > Mode > Assign Profile or Edit > Assign

Profile. Then select one of the following as the Profile setting:

m A different RGB working space (or Profile), such as ColorMatch RGB or

sRGB IEC61966-2.1
B A scanner profile for your scanner
B A camera profile for your digital camera
Click the Preview box to see the effects of your profile choice on the screen.

6. Select Page Setup from the File menu, select your page settings, and click
OK.
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7. Select File, then select Print or Print with Preview.

10.

11.
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If necessary, click More Options or Show More Options, then select Color

Management.

Under Color Handling, select Let Photoshop Determine Colors or

Photoshop Manages Colors.

Under Profile or Printer Profile, select a profile for your printer and the
paper you'll use. If you're printing with Epson Premium ICC profiles, select
the profile that also matches the print quality you want to use, such as

SPR1900 PrmGlsy BstPhoto.icc.

For the Intent or Rendering Intent setting, select Relative Colorimetric
and click the Black Point Compensation checkbox.

Note:

If your image contains very saturated colors, select Perceptual. This reduces the
color saturation so that the colors fit within the printer’s color gamut.
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Selecting Print Settings and Printing

1. Click the Print button, select your printer, and click Properties or

Preferences.
2. Click the Advanced tab.

3. Ifyou are using an Epson Premium
ICC profile, set the print quality
setting to match your profile.

4. Select the Type setting for your paper
(see page 22).
5. Turn off the High Speed and Edge

Smoothing options, if available.

6. Select the ICM button under Color
Management, then check the Off (No
Color Adjustment) box.

Note:

W81 EPSON Stylus Photo R1900 Series Properties (===

8 Man | &3 Advanced [ Page Layout | e Mamenance |
Fape & Gually Optiorss Color Management

Cobor Contioky

CustemSetings = [ Gown Betting |

.mﬂudnefm | O Supget |
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Make sure that you select Off (No Color Adjustment). If you don't, the printer
driver will apply additional correction to the image data, producing inaccurate

results.

7. Ifyou are printing on any of the following glossy media, make sure the Gloss

checkbox is selected:

Ultra Premium Photo Paper Glossy

B Premium Photo Paper Glossy
B Premium Photo Paper Semi-gloss
B Ultra Premium Photo Paper Luster

PremierArt Water Resistant Canvas

8. Click OK, then click OK or Print to print your photo.

Note:

If you selected the wrong combination of source profile, printer profile, and color
management settings, you'll get unexpected results. If your printed image is darker
than expected and/or has a strong yellow-brown cast, you probably turned off color
management in both Photoshop and the Epson printer driver. If your printed image is
lighter than expected and/or has a strong light blue cast, you probably turned on color
management in both Photoshop and the Epson printer driver.
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Macintosh Printing With a Color Profile

First set up your color management environment in Photoshop and assign a
profile to your image, then select your print settings and print.

Setting Up Photoshop and Assigning a Profile
1. Open Photoshop.

2. Select Color Settings from the Photoshop or Edit menu. You see this
window:

Color Settings

-+~ For more information on color settings, search for “setting up color E
(1) management” in Help. This term is searchable from any Creative ( )
" suite application. > <
7 z = € Cancel )
(Sslllngs North America Prepress 2 I !—) SA————

§ Load... )

— Warking Spaces

RGB: | Adobe RGB (1998) Save... )

CMyk: | U.S. Web Coated (SWOP) w2

(" More Options 3

Gray: | Dat Gain 20%

@ Preview

Spot: [ Dat Gain 20%

| o] 4] {4

— Color Policies

RGB: | Preserve Embedded Profiles | g
€Myk: | Preserve Embedded Profiles |14
Gray:| Preserve Embedded Profiles |4

Profile Mismatches: [@ Ask When Opening [ Ask When Pasting
Missing Profiles; @] Ask When Opening

— Description

North America Prepress 2: Freparation of content for common printin
conditions in North America. CMYK values are preserved. Profile warnings are
enabled.

3. Select U.S. Prepress Defaults or North America Prepress 2 from the
Settings menu to set Adobe RGB (1998) as the color space. Click OK.

4. Open the photo you want to print.

If you see an Embedded Profile Mismatch message, select Use the
embedded profile and click OK.

If you see a Missing Profile message, select Assign working RGB: Adobe
RGB (1998) and click OK.

5. When your image appears, evaluate the color balance and contrast. If they
need improvement, select Image > Mode > Assign Profile or Edit > Assign
Profile.
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Then select one of the following as the Profile setting:

B A different RGB working space, such as ColorMatch RGB or sRGB
IEC61966-2.1

B A scanner profile for your scanner
B A camera profile for your digital camera
Click the Preview box to see the effects of your profile choice on the screen.

6. Select File, then click Print or Print with Preview.

Frint

Printer
Stybus Phata 1. 18]

7. If necessary, click More Options or Show More Options, then select Color
Management.

8. Click Page Setup, select page settings as necessary, and click OK.

9. Under Color Handling, select Let Photoshop Determine Colors or
Photoshop Manages Colors.

10. Under Profile or Printer Profile, select a profile for your printer and the
paper you'll use. If you're printing with Epson Premium ICC profiles, select
the profile that also matches the print quality you want to use, such as
SPR1900 PrmGlsy BstPhoto.icc.

11. As the Intent or Rendering Intent setting, select Relative Colorimetric and
click the Black Point Compensation checkbox.

Note:
If your image contains very saturated colors, select Perceptual. This reduces the
color saturation so that the colors fit within the printer’s color gamut.
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Selecting Print Settings and Printing

1. Click the Print button, select L
Stylus Photo R1900, and select T
Print Settings.

2. Select the Media Type setting for — ::.:: = D)
your paper (see page 22). VMCL":"J:J )
Click the Advanced button. P :9,";?.1.

&5 ;

4. Ifyou are using an Epson g.fff;::f.:,.:m." —

Premium ICC profile, set the Print m—
Quality setting to match your
pfOﬁlC. 7) (_PoFw ) ( Preview ) [ Supghes Cancel ) (Ebrint)

5. Ifyou are printing on any of the following glossy media, make sure Gloss
Optimizer is set to On:

Ultra Premium Photo Paper Glossy
Premium Photo Paper Glossy
Premium Photo Paper Semi-gloss

Ultra Premium Photo Paper Luster

PremierArt Water Resistant Canvas

6. Turn off the High Speed option.

7. Select Color Management, then o
select Off (No Color Adjustment). — Wé_:
Note: or—)

O Calor Controls

Make sure that you select Off (No S
Color Adjustment). If you don't, the

printer driver will apply additional
correction to the image data,

producing inaccurate results. B T () G o __
8. Click Print to print your photo.

Note:

If you selected the wrong combination of source profile, printer profile, and color
management settings, you'll get unexpected results. If your printed image is darker
than expected and/or has a strong yellow-brown cast, you probably turned off color
management in both Photoshop and the Epson printer driver. If your printed image is
lighter than expected and/or has a strong light blue cast, you probably turned on color
management in both Photoshop and the Epson printer driver.
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Printing on CDs and DVDs

You can use your R1900 Series and the Epson Print CD software that came with it
to print label designs directly onto ink jet-printable CDs or DVDs.

Before you load a CD or DVD, be sure to clean the rollers inside the printer, as
described below. Also burn files, music, or video onto your CD or DVD before
printing on it to prevent errors.

Then follow the steps in these sections:

B “Loading a CD or DVD” on page 31

B “Printing on a CD or DVD” on page 32

B “Removing Your Printed CD/DVD” on page 33

Note:

If you're using discs where the printable area extends to within 0.16 inch (4 mm) of the
edge of the center hole, you may need to adjust the Inner Diameter setting in the File
menu of the Epson Print CD software. See the program'’s Help utility for instructions.

Cleaning the Rollers

Before you print on a CD or DVD, it’s a good idea to clean the rollers inside the
printer by feeding several sheets of plain paper through it.

1. Turn on the printer.

2. Load several sheets of plain paper in the sheet feeder (see page 6).
3. DPress the 3@ paper button to feed the paper through the printer.
4. Press the @ paper button again to eject the paper.
5

Feed several sheets of paper in this way to completely clean the rollers.
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Loading a CD or DVD

1. First burn files, music, or video onto your CD or DVD before printing on it
to prevent errors.

2. Turn on the printer.
Clean the rollers inside the printer (see page 30).

4. Remove any paper loaded in the sheet feeder and remove the single sheet
guide, if it is installed. Also close the paper support.

5. Open the output tray, but do not pull out the extensions. Then open the
CD/DVD tray guide cover.

12-cm discs 8-cm discs

Note:
For small 8-cm discs, place the adapter on the tray and then place the disc in the
adapter.
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7. Insert the CD/DVD tray into the tray guide
and slide it into the printer beneath the guide
rails until the arrows are aligned.

When you send your CD/DVD print job to the
printer, it automatically places the disc in the
correct print position and ejects it automatically
when printing finishes.

Caution:

Do not turn the R1900 Series on or off with a CD or
DVD loaded in it. Always remove the disc first (see
page 33).

Printing on a CD or DVD

When you installed the software for the R1900 Series, you installed the Epson
Print CD program for printing label designs directly onto CDs or DVDs. Follow
these steps to open the program and print on the disc you loaded in the printer:

1. Do one of the following to start Epson Print CD:
Windows: Double-click the EPSON Print CD icon on your desktop.

Macintosh: Open the Applications folder, open the EPSON Print CD folder,
and double-click EPSON Print CD.
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2. Follow the instructions in the on-screen Reference Guide to design your disc
label. You can use the tools on the screen to add text and provided background
designs, or add your own designs or photos.

3. When you're ready to print on the disc, open the File menu and select Print.
You see one of these windows:
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4. Select EPSON Stylus Photo R1900 Series (Windows) or Stylus Photo
R1900 (Macintosh), if necessary.

5. Click Print.

Removing Your Printed CD/DVD

After your CD or DVD is printed, the tray ejects partially from the R1900 Series.

Pull out the tray and remove the disc.

Caution:
Do not turn the R1900 Series on or off with a CD or DVD loaded in it. Always remove
the disc first.

After printing, handle the printed CD or DVD carefully. You may need to wait up
to 24 hours for the ink to dry fully before inserting it in a drive. Keep printed discs
away from moisture and direct sunlight.

If you need to adjust the print position or print quality, see your on-screen
Reference Guide for instructions.
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Maintaining Your Printer

Follow the steps in these sections to keep the R1900 Series working at its best:

“Checking and Cleaning the Print Head” below

“Checking and Aligning the Print Head” on page 35

“Checking the Ink Cartridge Status” on page 36
B “Replacing Ink Cartridges” on page 37

Checking and Cleaning the Print Head

You can check and clean the print head nozzles automatically using the Auto
Nozzle Check and Cleaning utility in your printer software. It prints a check
pattern that your printer then reads to see if you have any clogged nozzles, which it
then cleans, if necessary.

1. Load a few sheets of plain paper in the sheet feeder (see page 6).

2. Do one of the fOllOWiI‘lg: & Auto Nozzle Check and Cleaning I )

Windows: Right-click the & icon in
the bottom right corner of your screen

A nozde check and, if necessary, & head cleaning will bs perfarmed

tomaticall
(the taskbar) and select Auto Head ]
C . Use this utity i printouts are blumy or the color is inconect or missing
I eaning. W Make sure that several shests of Ad or Letter size plain paper are loaded
R inthe sheetfeeder
1 . H 1 The automatic head cleaning process takes from 4 to 22 minutes to
Macintosh: Open the Applications Do b

folder, open the EPSON Printer
Utility2, select SP R1900, and click

OK. Then select Auto Head e () |

Cleaning.

3. Click Start and follow the on-screen instructions to allow the printer to print
and examine the nozzle check pattern. If necessary, the printer cleans the print
head, and may print and check the nozzle check pattern a few times.

If nozzles are still clogged, you see a message telling you to clean the print
head manually. See the on-screen Reference Guide for instructions.
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Note:
If you don't see any improvement after cleaning the print head four times, turn off your
printer and wait at least six hours to let any dried ink soften. Then try printing again.

If you do not use your R1900 Series often, it is a good idea to print a few pages at least
once a month to maintain good print quality.

Checking and Aligning the Print Head

If your printouts become grainy or blurry, or you see dark or light bands across
them, you may need to align the print head.

It’s best to run the automatic alignment utility first to let the printer check and
align the print head, if necessary. If you still notice alignment problems, you can
align the print head manually.

Note:
Banding may also occur if your print head nozzles need cleaning (see page 34).

1. Load a few sheets of Epson Presentation Paper Matte (or the photo paper you
have on hand) in the sheet feeder (see page 6). It’s best to use matte or photo
paper for the most accurate alignment.

2. Do one of the following:

Windows: Right-click the B icon in  [Grnrassme Dl %)

the bottom right corner of your screen || | ey sesssiman timoses v sty enens
(the taskbar) and select Print Head

Al Ig nment. Automatic s generall recammended.

Macintosh: Open the Applications

folder, open the EPSON Printer (ot oww )
Utility2, select SP R1900, and click

OK. Then select Print Head

Alignment.

3. To have the printer check and align the print head automatically, click
Automatic, then click OK. Follow the on-screen instructions to print the
alignment check patterns and align the print head as necessary.

To align the print head manually, click the Manual button and follow the
on-screen instructions, or see the on-screen Reference Guide for detailed steps.
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Checking the Ink Cartridge Status

Your R1900 Series will let you know when an ink cartridge is low or expended in
the following ways:

B The O ink light flashes when ink is low in one or more cartridges.
B The O ink light stays on when an ink cartridge is expended.

B Your computer screen displays a message when you try to print. This window
can optionally display ink offers and other updates retrieved from an Epson
website.

Note:

On a Windows computer that is connected to the Internet, you may see a screen
asking if you want to receive Epson offers the first time you try to print when ink is low.
Click Accept or Decline. To disable checking for ink offers or updates from Epson, see
the instructions in your on-screen Reference Guide.

You cannot print when an ink cartridge is expended even if the other cartridges are
not expended. Replace any expended cartridges before printing.

To check the ink cartridge status at anytime, do Do v G e ==
one of the following: EPSON "=

Pt prire -
Windows: ’s

Double-click the B icon in the bottom right —eT—
corner of your screen (the taskbar). \]/] M“ b HJ “ _]-:'-:”. ]’]
[ i

You see the screen to the right.

Ik Liveky

Irfuarshon

Macintosh: ) I

1. Open the Applications folder.

Y08 EPSON Statusanitor
2. Open the EPSON Printer Utility2. woon Bz wnowonss
3. Select SP R1900, click OK, and select e

EPSON StatusMonitor.

You see the screen to the right. j H B B D B Dj

Ok the image of the ink canridge to degiay
INfOrmation Aot T CUTeNt CaTtrdge.

Updue )} (0SS
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Replacing Ink Cartridges

You can purchase genuine Epson ink and paper at Epson Supplies Central at
www.epson.com/ink3 (U.S. sales) or www.epson.ca (Canadian sales). You can
also purchase supplies from an Epson authorized reseller. To find the nearest one,

call 800-GO-EPSON (800-463-7766).

Use the following list when you order or purchase new ink cartridges:

Part number on
Ink color or cartridge type Part number software screens
Photo Black 87 T0871
Matte Black 87 T0878
Cyan 87 T0872
Magenta 87 T0873
Yellow 87 T0874
Red 87 10877
Orange 87 T0879
Gloss Optimizer 87 T0870

Note:

We recommend that you use genuine Epson cartridges and do not refill them. The use
of other products may affect your print quality and could result in printer damage.

Yields vary considerably based on images printed, print settings, paper type, frequency
of use, and temperature. For print quality, a small amount of ink remains in the cartridge
after the “replace cartridge” indicator comes on. The printer ships with full cartridges
and part of the ink from the first cartridges is used for priming the printer.

For best printing results, use up a cartridge within six months of opening the package.

Caution:

Do not open ink cartridge packages until you are ready to install the ink. Cartridges are
vacuum packed to maintain reliability.

Leave your old cartridges in the R1900 Series until you are ready to replace them to
prevent the print head nozzles from drying out.

Remove the CD/DVD tray before replacing ink cartridges.
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Make sure you have a new ink cartridge before you begin. You must install new
cartridges immediately after removing the old ones.

1. Remove any roll paper or canvas media loaded in the printer to prevent ink
marks on the paper (see page 12).

2. Open the printer cover.

3. Press the O ink button to move the print head to the ink replacement position.
If a cartridge is low or expended, the light above the cartridge flashes or stays
on.

Caution:
Don’t move the print head by hand or touch the flat white cable
behind the print head to avoid damaging your printer.

4. Open the cartridge cover.

5. Squeeze the tab on the cartridge and lift the
cartridge straight up to remove it. Dispose of it
carefully. Do not take the used cartridge apart
or try to refill it.

Warning:

If ink gets on your hands, wash them thoroughly
with soap and water. If ink gets into your eyes,
flush them immediately with water. Keep ink
cartridges out of the reach of children.
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Before opening the cartridge package, shake the package four or five times.

Note:
All cartridges, except the gloss optimizer cartridge, make a clicking sound when
you shake them.

Caution:
Do not shake the cartridges after opening the packages or ink will leak.

Remove the cartridge from the package, but be careful not to touch the green
chip on the cartridge.

Remove the yellow tape from the bottom of the cartridge.

Caution:
Do not remove any other labels or seals, or ink will leak.

place.
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10. Once you replace all the necessary cartridges, close the cartridge cover and
push it down until it clicks into place.

11. Close the printer cover.

12. Press the O ink button to begin charging the ink. This takes about
2 1/2 minutes. The O power light flashes as the ink charges.

J{ J

When the O power light stops flashing and the O ink light goes out, ink
charging is finished.

Caution:
Never turn off the R1900 Series while ink is charging or you'll waste ink.

If the O ink light is flashing, press the 0 ink button, then press down all the
cartridges securely.

If you remove a low or expended ink cartridge, you cannot reinstall and use the
cartridge.
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Solving Problems

Check the status of the printer lights to diagnose the cause of most problems (see
below), or check the solutions beginning on page 43 for more information.

Open your on-screen Epson Information Center for detailed help and easy access to
Epson’s support website, FAQs, paper and ink purchasing, and Reference Guide.

Checking for Software Updates

Periodically, it’s a good idea to check Epson’s support website

for free updates to your Epson Stylus Photo R1900 Series Download the
software. Open your on-screen Epson Information Center and o
select Download the Latest Software or visit Epson’s support \j&ﬂa‘;
website at epson.com/support (U.S.) or epson.ca (Canada).

With Windows, you can select Driver Update on the Maintenance tab in the
printer settings window. You can also click Start or @, select Programs or All
Programs, select EPSON, and click EPSON Stylus Photo R1900 Series
Driver Update.

Checking the Printer Lights

Check the status of the printer lights to solve the most common problems.

Light status Problem and solution

B@ paper on Paper may be out or multiple sheets may have fed into
the sheet feeder. Load paper, if necessary (see page 6),
and press the B@ paper button.

Roll paper or canvas media may be out. See page 10 to
load roll paper.

The CD/DVD tray may not be inserted. See page 31 to
load a CD or DVD.
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Light status

Problem and solution

w@ paper flashing

Paper may have jammed in the sheet feeder, manual
feed slot, or roll paper slot.

Sheet Feeder or Manual Feed Slot: Press the

B@ paper button to eject any jammed sheets, then open
the printer cover and remove any paper jammed inside.
Press the p@ paper button again to clear the error.

Roll Paper Slot: Cut off any printed roll paper or canvas
media, then remove (see page 12) and reload (see
page 10) the paper.

The CD/DVD tray may be unable to eject. Gently pull
out the CD/DVD tray and press the z@ paper button.
See page 31 to reload the tray.

The printer cover may be open. Close the printer cover
to continue. (Leaving the printer cover open stops or
prevents printing.)

O ink on An ink cartridge is expended or not installed correctly,
or is not compatible with the printer. Replace or
reinstall the cartridge (see page 37).

0 ink flashing Ink in a cartridge is low. You can continue printing, or

check which cartridge is low (see page 36) and replace
it (see page 37).

m@ paper flashing
0 ink flashing fast

The CD/DVD tray guide cover is open while printing
from paper loaded in the sheet feeder. Remove the
loaded paper to print on a CD or DVD or close the
CD/DVD guide cover to print on paper (see page 31 to
locate the CD/DVD tray guide cover). Press the

B@ paper button to clear the error.

m@ paper and 0 ink flashing
or flashing alternately

An unsupported device is connected to the ¢ external
USB port. Connect only a PictBridge compatible digital
camera to the A external USB port (see the on-screen
Reference Guide).

O power off
»@ paper and 0 ink flashing
alternately

Parts inside the R1900 Series are at the end of their
service life or an unknown error has occurred. Contact
Epson for help (see page 45).

O power off
w@ paper and O ink flashing
fast

The print head is obstructed by paper or other foreign
material. Turn off the printer, remove any obstructions,
and turn it back on. If the error persists, contact Epson
(see page 45).
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Problems and Solutions

Check the solutions below if you're having trouble using your printer.

Printing Problems

B Make sure your paper is loaded printable side up, short edge first, and against
the right side with the edge guide against it (see page 6 and page 8).

B Don't load paper above the arrow mark inside the sheet feeder edge guide.
Load only one sheet of compatible paper using the single sheet guide (see

page 8).

B Make sure the paper size settings in the printer software are correct for the
paper you loaded.

W If the o8 paper is flashing and printing has stopped, make sure the printer
cover is closed. Leaving the printer cover open stops or prevents printing.

Paper Feeding Problems

W If paper doesn’t feed into the sheet feeder, remove it and flip through the stack
to separate the sheets. Reload paper against the right side and slide the edge
guide against it. Also, do not load too many sheets in the sheet feeder at once
(see page 6) and make sure the printer cover is closed.

W If paper loaded using the single sheet guide doesn’t feed, make sure you
installed the guide correctly and guided the paper all the way into the printer
(see page 8). Also make sure the printer cover is closed.

W Ifroll paper doesn’t feed, cut the end of it straight across and uncurl the end
by rolling it backwards, if necessary. Then reload the paper carefully (see
page 10) and make sure the printer cover is closed.

W If paper is jammed, try the following, depending on how you're printing:

Sheet feeder or manual feed slot: Press the 5 paper button to eject any
jammed sheets, then open the printer cover and remove any paper jammed
inside. Press the p@ paper button again to clear the error, then reload paper.

Roll paper slot: Cut off any printed roll paper or canvas media, then remove
(see page 12) and reload (see page 10) the paper.
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CD/DVD Printing Problems

If the CD/DVD tray won't load or jams in the printer, gently pull out the
CD/DVD tray and press the p@ paper button, if it is flashing. Reload the
CD/DVD tray, making sure to insert the tray correctly in the tray guide and
align the arrows (see page 31). Also make sure the printer cover is closed.

If your image is not positioned correctly on the disc or does not cover the
printable area correctly, you may need to adjust the printing position using the
Epson Print CD software. See the on-screen Reference Guide for instructions.

If ink smears on your disc, make sure you're printing on ink jet-printable CDs
or DVDs and that the surface of the disc is dry. Handle printed discs carefully
and let them dry for 24 hours before inserting them in a drive. If necessary,
you can adjust the print quality using Epson Print CD software. See the
on-screen Reference Guide for instructions.

Print Quality Problems

For the best print quality, use Epson papers (see page 13) and genuine Epson
ink cartridges (see page 37).

Load the paper printable side up (usually the whiter, brighter, or glossy side).
Make sure your paper isn’t damp or curled.

Use a support sheet with special paper (sheet feeder only) or load one sheet at
a time.

Make sure the type of paper you loaded matches the paper size and paper type
settings in your printer software (see page 22).

Remove sheets from the output tray as they eject. Let your prints dry
separately for at least 12 hours before framing or placing in a protective sheet.
If you need to stack them, place a sheet of plain paper between each print.

If you notice light or dark bands across your printouts or they are too faint,
you may need to clean the print head. Run the Auto Nozzle Check and
Cleaning utility to automatically check and clean the print head (see page 34).

If you notice jagged vertical lines, run the Print Head Alignment utility to
automatically check and align the print head (see page 35).

The ink cartridges may be low on ink. Check your cartridge status (see
page 36) and replace cartridges, if necessary (see page 37).
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Where To Get Help

Epson Technical Support

Internet Support

Visit Epson’s support website at epson.com/support and select your product for
solutions to common problems. You can download drivers and documentation,
get FAQs and troubleshooting advice, or e-mail Epson with your questions.

Speak to a Support Representative
Before you call Epson for support, please have the following information ready:

Product name (Epson Stylus Photo R1900 Series)
Product serial number (located on the label in back)
Proof of purchase (such as a store receipt) and date of purchase

Computer configuration

Description of the problem
Then call:
B U.S.: (562) 276-7296, 6 AM to 6 PM, Pacific Time, Monday through Friday

B Canada: (905) 709-2567, 6 AM to 6 PM, Pacific Time, Monday through
Friday

Days and hours of support are subject to change without notice. Toll or long
distance charges may apply.

Purchase Supplies and Accessories

You can purchase genuine Epson ink and paper at Epson Supplies Central at
www.epson.com/ink3 (U.S. sales) or www.epson.ca (Canadian sales). You can
also purchase supplies from an Epson authorized reseller. To find the nearest one,

call 800-GO-EPSON (800-463-7766).

Solving Problems 45



46

Notices

Important Safety Instructions

Before using your R1900 Series, read and follow these safety instructions:

B Be sure to follow all warnings and instructions marked on the R1900 Series.

B Use only the type of power source indicated on the R1900 Series label.

B Use only the power cord that comes with the R1900 Series. Use of another cord may
cause fires or shock. Do not use the cord with any other equipment.

B Dlace the R1900 Series near a wall outlet where the plug can be easily unplugged.

B Ifyou won’t be using the R1900 Series for a long period, unplug the power cord from
the electrical outlet.

B Always turn off the R1900 Series using the O power button, and wait until the
O power light stops flashing before unplugging the printer or cutting off power to
the electrical outlet.

B Avoid plugging the R1900 Series into an outlet on the same circuit as a photo copier
or air control system that regularly switches on and off, or on an outlet controlled by a
wall switch or timer.

B Do not let the power cord become damaged or frayed.

B Ifyou use an extension cord with the R1900 Series, make sure the total ampere rating
of the devices plugged into the extension cord does not exceed the cord’s ampere
rating. Also, make sure the total ampere rating of all devices plugged into the wall
outlet does not exceed the wall outlet’s ampere rating.

B Avoid locations that are subject to rapid changes in heat or humidity, shocks or
vibrations, or dust.

B Leave enough room around the R1900 Series for sufficient ventilation. Do not block
or cover openings in the R1900 Series case or insert objects through the slots.

B Do not place the R1900 Series near a radiator or heating vent or in direct sunlight.
Do not use aerosol products that contain flammable gases inside or around the R1900
Series. Doing so may cause fire.

B Place the R1900 Series on a flat, stable surface that extends beyond its base in all
directions. It will not operate properly if it is tilted or at an angle.

B Make sure the R1900 Series is at least 4 inches (10 cm) away from the wall.

Do not touch the flat white cable inside the R1900 Series.
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Do not spill liquid on the R1900 Series.

B Except as specifically explained in your documentation, do not attempt to service the
R1900 Series yourself.

B Unplug the R1900 Series and refer servicing to qualified service personnel under the
following conditions: if the power cord or plug is damaged; if liquid has entered the
product; if the product has been dropped or the case damaged; if the product does not
operate normally or exhibits a distinct change in performance. Adjust only those
controls that are covered by the operating instructions.

B When storing or transporting the R1900 Series, do not tilt it, stand it on its side, or
turn it upside down; otherwise ink may leak from the cartridges.

Ink Cartridge Safety Instructions

Keep ink cartridges out of the reach of children and do not drink the ink.

B Be careful when you handle used ink cartridges; there may be ink remaining around
the ink supply port. If ink gets on your skin, wash it off with soap and water. If it gets
in your eyes, flush them immediately with water.

B Do not put your hand inside the R1900 Series or touch any cartridges during
printing.

B Install a new ink cartridge immediately after removing an expended one. Leaving
cartridges uninstalled can dry out the print head and may prevent the R1900 Series
from printing.

B Ifyou remove an ink cartridge for later use, protect the ink supply area from dirt and
dust and store it in the same environment as the R1900 Series. Note that there is a
valve in the ink supply port, making covers or plugs unnecessary, but care is needed to
prevent the ink from staining items that the cartridge touches. Do not touch the ink
cartridge ink supply port or surrounding area. Do not store the cartridge upside
down.

Important Safety Instructions
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Epson America, Inc., Limited Warranty

What Is Covered: Epson America, Inc. (“Epson”) warrants to the original retail purchaser
that the Epson printer covered by this limited warranty statement, if purchased and
operated only in the United States or Canada, will be free from defects in workmanship
and materials for a period of one (1) year from the date of original purchase. For warranty
service, you must provide proof of the date of original purchase.

What Epson Will Do To Correct Problems: Should your Epson printer prove defective
during the warranty period, please call the Epson Connection®™ at (562) 276-7296 (U.S.)
or (905) 709-2567 (Canada) for warranty repair instructions and return authorization. An
Epson service technician will provide telephone diagnostic service to determine whether
the printer requires service. If service is needed, Epson will, at its option, exchange or
repair the printer without charge for parts or labor. If Epson authorizes an exchange for the
defective unit, Epson will ship a replacement printer to you, freight prepaid, so long as you
use an address in Canada or the U.S. (excluding Puerto Rico and U.S. Possessions).
Shipments to other locations will be made freight collect. You are responsible for securely
packaging the defective unit and returning it to Epson within five (5) working days of
receipt of the replacement. Epson requires a debit or a credit card number to secure the
cost of the replacement printer in the event that you fail to return the defective one. If your
printer is being repaired, Epson will direct you to send your printer to Epson or its
authorized service center, where the printer will be fixed and sent back to you. You are
responsible for packing the printer and for all costs to and from the Epson authorized
service center. When warranty service involves the exchange of the printer or a part, the
item replaced becomes Epson property. The replacement printer or part may be new or
refurbished to the Epson standard of quality, and, at Epson’s option, may be another
model of like kind and quality. Epson’s liability for replacement of the covered printer will
not exceed the original retail selling price of the covered printer. Exchange products and
parts assume the remaining warranty period of your original product covered by this
limited warranty.

What This Warranty Does Not Cover: This warranty covers only normal use in the
United States and Canada. Using this product for continuous production or similar high
duty purposes is not considered normal use; damage, maintenance or service from such use
will not be covered under this warranty. This warranty is not transferable. This warranty
does not cover any color change or fading of prints or reimbursement of materials or
services required for reprinting. This warranty does not cover damage to the Epson
product caused by parts or supplies not manufactured, distributed or certified by Epson.
This warranty does not cover ribbons, ink cartridges or third party parts, components, or
peripheral devices added to the Epson product after its shipment from Epson, e.g., dealer
or user-added boards or components. Epson is not responsible for warranty service should
the Epson label or logo or the rating label or serial number be removed or should the
product fail to be properly maintained or fail to function properly as a result of misuse,
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abuse, improper installation, neglect, improper shipping, damage caused by disasters such
as fire, flood, and lightning, improper electrical current, software problems, interaction
with non-Epson products, or service other than by an Epson Authorized Servicer. If a
claimed defect cannot be identified or reproduced, you will be held responsible for the
costs incurred.

THE WARRANTY AND REMEDY PROVIDED ABOVE ARE EXCLUSIVE AND IN
LIEU OF ALL OTHER EXPRESS OR IMPLIED WARRANTIES INCLUDING, BUT
NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY,
NON-INFRINGEMENT OR FITNESS FOR A PARTICULAR PURPOSE. SOME
LAWS DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES. IF
THESE LAWS APPLY, THEN ALL EXPRESS AND IMPLIED WARRANTIES ARE
LIMITED TO THE WARRANTY PERIOD IDENTIFIED ABOVE. UNLESS
STATED HEREIN, ANY STATEMENT OR REPRESENTATIONS MADE BY ANY
OTHER PERSON OR FIRM ARE VOID. EXCEPT AS PROVIDED IN THIS
WRITTEN WARRANTY, NEITHER EPSON AMERICA, INC. NOR ITS
AFFILIATES SHALL BE LIABLE FOR ANY LOSS, INCONVENIENCE, OR
DAMAGE, INCLUDING DIRECT, SPECIAL, INCIDENTAL OR
CONSEQUENTIAL DAMAGES, RESULTING FROM THE USE OR INABILITY
TO USE THE EPSON PRODUCT, WHETHER RESULTING FROM BREACH OF
WARRANTY OR ANY OTHER LEGAL THEORY.

In Canada, warranties include both warranties and conditions.

Some jurisdictions do not allow limitations on how long an implied warranty lasts, and
some jurisdictions do not allow the exclusion or limitation of incidental or consequential
damages, so the above limitations and exclusions may not apply to you. This warranty
gives you specific legal rights and you may have other rights which vary from jurisdiction
to jurisdiction.

To find the Epson Authorized Reseller nearest you, visit our website at:
heep://www.epson.com.

To find the Epson Customer Care Center nearest you, visit
hetp://epson.com/support.

You can also write to:
Epson America, Inc., P.O. Box 93012, Long Beach, CA 90809-3012
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Declaration of Conformity

According to 47CFR, Part 2 and 15 for: Class B Personal Computers and Peripherals;
and/or CPU Boards and Power Supplies used with Class B Personal Computers:

We: Epson America, Inc.
Located at: MS 3-13
3840 Kilroy Airport Way
Long Beach, CA 90806
Telephone: (562) 290-5254

Declare under sole responsibility that the product identified herein, complies with 47CFR
Part 2 and 15 of the FCC rules as a Class B digital device. Each product marketed is
identical to the representative unit tested and found to be compliant with the standards.
Records maintained continue to reflect the equipment being produced can be expected to
be within the variation accepted, due to quantity production and testing on a statistical
basis as required by 47CFR §2.909. Operation is subject to the following two conditions:
(1) this device may not cause harmful interference, and (2) this device must accept any
interference received, including interference that may cause undesired operation.

Trade Name: Epson
Type of Product: Ink jet printer
Model: B431A

Notices



FCC Compliance Statement

For United States Users

This equipment has been tested and found to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference in a residential installation. This
equipment generates, uses, and can radiate radio frequency energy and, if not installed and
used in accordance with the instructions, may cause harmful interference to radio or
television reception. However, there is no guarantee that interference will not occur in a
particular installation. If this equipment does cause interference to radio and television
reception, which can be determined by turning the equipment off and on, the user is
encouraged to try to correct the interference by one or more of the following measures:

B Reorient or relocate the receiving antenna.
B Increase the separation between the equipment and receiver.

B Connect the equipment into an outlet on a circuit different from that to which the
receiver is connected.

B Consult the dealer or an experienced radio/TV technician for help.

WARNING

The connection of a non-shielded equipment interface cable to this equipment will
invalidate the FCC Certification of this device and may cause interference levels which
exceed the limits established by the FCC for this equipment. It is the responsibility of the
user to obtain and use a shielded equipment interface cable with this device. If this
equipment has more than one interface connector, do not leave cables connected to
unused interfaces. Changes or modifications not expressly approved by the manufacturer
could void the user’s authority to operate the equipment.

For Canadian Users

This Class B digital apparatus complies with Canadian ICES-003.
Cer appareil numérique de la classe B est conforme & la norme NMB-003 du Canada.
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